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Say Hello to Your Network Tools
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PCAPNG and PCAP Formats

• Before we jump into pcap analysis…

• Interfaces and mergecap

© 2021 0Byte 0ffset, LLC



Tcpdump

• Command line tool for capturing/analyzing network traffic

• Not need for deep packet inspection

• Example: -x –X -s

• Example:

•
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Tcpdump
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Wireshark
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View -> Time Display Format -> UTC Date and Time of Day



Wireshark
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View -> Name Resolution -> Nothing Checked

Recommendation: Disable all Name Resolution



Wireshark
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View:



Zeek (formerly Bro IDS)
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NETRESEC suite of tools

• NetworkMiner

• CapLoader

• PolarProxy

• PacketCache

• RawCap

• TrimPCAP.py

• findject.py

• SplitCap

• SPID
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https://www.netresec.com/?page=Products

https://www.netresec.com/?page=Products


PolarProxy

Source: https://www.netresec.com/?page=PolarProxy

List FAQs
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NetworkMiner
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> mono NetworkMiner_2-7-1/NetworkMiner.exe --noupdatecheck

• Uses mono – a free and open-source .NET Framework-

compatible software.



NetworkMiner - pcapng

Source: https://pcapng.com/

• CapLoader (free trial or professional ver $$$)

• https://www.netresec.com/?page=CapLoader

• tshark -F pcap -r {pcapng file} -w 

{pcap file} (warning: 

https://ask.wireshark.org/question

/1508/how-to-convert-pcapng-file-

to-pcap-file-by-tshark/)
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https://www.netresec.com/?page=CapLoader
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Lab 0001 – Filters: Tcpdump, Wireshark, Tshark

© 2021 0Byte 0ffset, LLC Actionable Data

DNS

HTTP
SMTP



Network Protocols

SSH

RDP

FTP

ICMP

TLS

NTP

SMTP

DNS HTTP

SMB

SNMP
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RFC – Request for Comments

• RFC 1, titled "Host Software", was written by Steve Crocker of the University of 

California, Los Angeles (UCLA), and published on April 7, 1969

RFC’s will be referenced here… 
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https://en.wikipedia.org/wiki/Steve_Crocker
https://en.wikipedia.org/wiki/University_of_California,_Los_Angeles


RFC Compliance

“But my firewall is RFC compliant…”

Source: https://xkcd.com/927/
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Network Protocols

DNS

© 2021 0Byte 0ffset, LLC



DNS

• Bonding Agent of the Internet 

• TCP and UDP

• Can be difficult to prevent malicious use

• Should be easier to detect malicious use

• SolarWinds attack – Sunburst Malware

• Vern Paxson

• Practical Comprehensive Bounds on Surreptitious Communication Over DNS

• http://www.icir.org/vern/papers/covert-dns-usec13.pdf

• TL/DR – Various methods to do bad things covertly using DNS
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http://www.icir.org/vern/papers/covert-dns-usec13.pdf


Direct DNS Resolution

Attacker Controlled Server

External Resolver

Internal Resolver
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Recursive DNS Resolution

Attacker Controlled Nameserver

External Resolver

Internal Resolver
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Network Protocols
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HTTP



HTTP Timeline

1996 1997 1999 2014 2015 2021

RFC 1945 HTTP/1.0

RFC 2068 HTTP/1.1

RFC 2616 HTTP/1.1

RFCs 7230 -7235 HTTP/1.1

- Message Syntax and Routing

- Semantics and Content

- Conditional Requests

- Range Requests

- Caching

- Authentication

RFC 7540 HTTP/2

RFC 7541 HTTP/2

- HPACK (Header Compression)

Draft-IETF HTTP/3

- QUIC
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HTTP

Scheme Domain Name Port Resource

http:// www.domain.com :80 /path/to/file.html
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http://www.domain.com:80/path/to/file.html

80 – Implied for HTTP

443 – Implied for HTTPS 



HTTP Headers

• Request Headers (Information about the resource requested or general client information)

• Response Headers (Information about the response or general server information)

• Representation Headers (Information about the body: MIME, Compression, etc.)

• Content-Type, Content-Encoding, Content-Language, Content-Location

• Payload Headers (Information about the payload data in general)

• Content-Length, Content-Range, Trailer, Transfer-Encoding
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Used by both Client and Server



HTTP – From the Client: Methods

• GET

• HEAD

• POST

• PUT

• DELETE

• CONNECT

• OPTIONS

• TRACE

• PATCH
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RFC 7231, Section 4: Request Methods

RFC 5789, Section 2: Patch Method



HTTP – From the Client: Methods

• GET – Requests a representation of the specified resource. 

• HEAD – Identical to GET except with no response body.

• POST – Used to submit data to the specified resource.

• PUT – Replaces all current representation of the specified resource.

• DELETE – Deletes the specified resource.

• CONNECT – Establishes a tunnel to the server by the specified resource.

• OPTIONS – Describes the communication options for the specified resource.

• TRACE – Performs a message loop-back test (useful for debugging).

• PATCH – Like PUT but can be applied for partial modifications to a resource.
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HTTP Status Codes

Source: https://www.steveschoger.com/status-code-poster/
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HTTP Status Codes

Source: https://www.steveschoger.com/status-code-poster/
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HTTP Status Codes

Source: https://www.steveschoger.com/status-code-poster/
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TLS

• SNI: Server Name Indication (extension)

• Wireshark filter:

• tls.handshake.extensions_server_name == "www.blackhillsinfosec.com"
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TLS

• Encapsulating Protocol

• Predecessor of SSL

• Layer 4: TCP

• Common Associated Ports: 443 (HTTP), 995 (POP), 465 (SMTP), +many 

more…

• Latest Version: 1.3 
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Encrypted SNI (ESNI)

• Extension to TLS 1.3 for “encrypted SNI”

• How?

• DNS, of course!



TLS – Client Hello
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TLS – Cipher Suites
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TLS – Cipher Suites
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SMTP
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SMTP



SMTP – Commands

• HELO/EHLO (EHLO for ESMTP)

• MAIL FROM

• RCPT TO

• DATA

• STARTTLS

• RSET

• QUIT
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SMTP – Reply codes

• 220 – SMTP Service Ready

• 221 – Service Closing

• 250 – Requested action taken and completed

• 354 – Start message input and end with… (<CR><LF>.<CR><LF>)

• 421 – Service unavailable

• 450 – Failed, Mailbox unavailable

• 500 – Command Aborted (server error)
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SMTP – Reply codes

• 220 – SMTP Service Ready

• 221 – Service Closing

• 250 – Requested action taken and completed

• 354 – Start message input and end with… (<CR><LF>.<CR><LF>)

• 421 – Service unavailable

• 450 – Failed, Mailbox unavailable

• 500 – Syntax Error

• 550 – Failed, Mailbox unavailable (common to see this in spam traffic) 

• 550 The mail server detected your message as spam
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SMTP in Action
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ICMP
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ICMP



ICMP

• RFC 792 – Echo Request (8), Echo Reply (0) – September 1981

• “The data received in the echo message must be returned in the echo 

reply message.”
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Common Protocols in the Environment

• FTP (Active/Passive) – TCP 21/20 (Calculated Data Ports )

• SSH – TCP 22

• SSHv1, SSHv2

• SMB – TCP 139/445 (445 for later versions)

• SMBv1, SMBv2, SMBv3

• RDP – TCP 3389

• NTP – UDP 123

• SNMP – UDP 161/162

• SNMPv1, SNMPv2c, SNMPv3
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File Carving

• Easy

• Easier

• Hard
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File Carving

• But wait! Let’s talk disk forensics for a moment…

• Filesystem Attributes

• What’s a filename anyways?
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File Carving - Wireshark
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File -> Export Objects -> <Select Protocol>



File Carving - Zeek
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zeek –Cr <file.pcap> /usr/local/zeek/share/zeek/policy/frameworks/files/extract-all-files.zeek

The “yolo” method:



File Carving – Old School

• Up hill, both ways, in 6 feet of snow…
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cat b64 | base64 –di | xxd



Lab 0010 – Carving Files out of PCAPS
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Attacker Techniques & Tactics 

• ATT&CK Framework

• Redirection/Shorteners

• Doppelganger Domains

• Encoding/Obfuscation

• Encryption

• Protocol Abuse
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MITRE ATT&CK - CnC

Tactic
TA0011: Command and Control

Techniques
T1071 – Application Layer Protocols



MITRE ATT&CK – CnC

Tactic
TA0011: Command and Control

Techniques
T1001 – Data Obfuscation

T1001.003 – Protocol Impersonation



Attacker Techniques & Tactics 

• Redirectors 

• Shorteners
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Attacker Techniques & Tactics 

• Doppelgangers

• Doppelgangers.com

• D0ppelgangers.com

• DoppeIgangers.com

• Dopelgangers.com

• Doppelgamgers.com

• Doppelganger.com
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Attacker TTP’s – Encoding & Obfuscation

• Base64

• Custom B64

• Reverse the Bytes

• Carrier Files (Files embedded in other files)
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Attacker TTP’s – Encoding & Obfuscation
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• Base64 versus Custom Base64:

• Thequickbrownfoxjumpoverthelazydog | base64

• VGhlcXVpY2ticm93bmZveGp1bXBvdmVydGhlbGF6eWRvZw== 

• A-Za-z0-9+/=

• l6xBsnlFoSJysCZTrCpLu6FRrn1LtClOt6xBr65WumhLpM== 

• 0-9a-zA-Z+/=



Attacker TTP’s – Encoding & Obfuscation
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Attacker TTP’s – Encoding & Obfuscation
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Reverse the bits…



Attacker TTP’s – Encryption  

• XOR the ways…

• Single Byte

• Null & Key Escaping

• Rolling  

• Native Algorithms

• RC4

• Etc…
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Attacker TTP’s – Protocol Abuse
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Attacker TTP’s – Protocol Abuse
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Attacker TTP’s – Protocol Abuse
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Network Protocol Abuse

FRAGILE

PLEASE HANDLE NETWORK PROTOCOLS 

IN ACCORDANCE WITH RFC

** THANK YOU **

How Attackers Profit Playing by the Rules
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Network Protocol Abuse 

• Manipulating protocol field values to carry out some nefarious act or agenda

• To bypass defensive solutions

• Objective: Remain undetected (greatest dwell time)

• Objective: Maintain Persistence (increased adversarial success rate)

• Not exactly exploitation to gain access/beachhead (although this is also abuse)

• NOT accidental

• Not all encompassing…not even close
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HTTP Status Type Manipulation

• 400 errors but still deliver payloads…

• Multiple threat actors have used this technique

Source:  

https://www.bleepingcomputer.com/news/security/hacke

rs-hiding-web-shell-logins-in-fake-http-error-pages/

• 404 – Not Found

Security Researcher (@nullcookies) discovered 

login pages to access web shells 



Turla – COMPfun Malware

Source: Kaspersky

• Status 402 – Payment Required??
• RFC 7231 6.5.2. “The 402 (Payment 

Required) status code is reserved for 

future use.”



Hidden Cobra – FakeTLS (PEEBLEDASH)

List of certificate URLs used in the TLS certificate



ICMPsh

https://logrhythm.com/images/blog-images/identifying-powershell-tunneling-through-icmp-2.png



DNSFtp

• https://github.com/breenmachine/dnsftp

• Types: TXT

https://github.com/breenmachine/dnsftp


DNSFtp



dnscat2

• https://github.com/iagox86/dnscat2

• Types: TXT, CNAME, MX

Source: https://zeltser.com/c2-dns-tunneling/

https://github.com/iagox86/dnscat2


DNS – Read the Labels 

• “Label me this Batman”

• Example using A record queries of hex-content

• python script

• No need to respond – just save the queries



DNS – Read the Labels 



DNS – Sunburst C2

CNAME 6a57jk2ba1d9keg15cbg.appsync-api.eu-west-1.avsvmcloud[.]com

Pointed to: freescanonline[.]com

Source: FireEye



DNS

• And the story of case-sensitivity…

• RFC 1035 – 2.3.3. Character Case – November 1987

When data enters the domain system, its original case should be preserved 

whenever possible. In certain circumstances this cannot be done. For example, if 

two RRs are stored in a database, one at x.y and one at X.Y, they are actually 

stored at the same place in the database, and hence only one casing would be 

preserved. The basic rule is that case can be discarded only when data is used to 

define structure in a database, and two names are identical when compared in a 

case insensitive manner.



DNS Case Sensitivity

• cd c:\

• 01100011 01100100 00100000 01100011 00111010 01011100 

00001010 00001010

• aUTksdLDdDDksEsfidTdfjrnsSLksrANnaQYSpSp.domain.com
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Lab 0011 – I XOR you, I XOR you NOT
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Lab 0100 – Proxy or No Proxy
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End Day 2

DAY 2 END
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